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Single-cavity Mold 

The purpose of this first part of the guide is to understand how the different types of documents related to the 
Mold document interact with each other, but also to know how to position basic elements such as the assembly 
resulting from the Split, and a standard mold base. 

Concepts addressed: 

- Types of documents linked to the Mold document 
- Positioning the Split elements and the standard mold base 
- Cavity process 
- Handling and viewing the sets 
- Drafting and bill of materials 
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Structure of documents 

 
  



TopSolid’Mold  Single-cavity Mold 

TopSolid   3 

Including an assembly resulting from the Split process 

Importing the package 

• From the Home tab,  import the project named TopSolid'Mold Training D1.TopPkg. 

Note: This package contains all the documents needed to complete all of the exercises in this training guide. 

Warning: Do not confuse the  Import Project command (formerly known as Import Project as Replication) 
which creates a new project or synchronizes your documents (data exchange between the PDM server and the local 

PDM for example) with the Import/Export >  Import Package command which creates new documents. You 
can only access the latter command by right-clicking on the node (root or folder) of a project. Halfway between 

these two commands, you can find the  Import Project as Distinct Copy command (TopSolid icon > File) 
which creates a new project and thus new documents. 

Including the assembly in a new mold document 

Note: There are many ways to include an assembly in a mold document: 

- Right-click on the assembly document's tab and select the  Mold command. 

- Or right-click on the assembly document in the Project tree and select the  Mold command. 

- Or create a new  document, select  Mold, and then  drag and drop the assembly document into 
the new mold document from the Project tree. 

• From the Project tree, open the Ex01 - Simple mold folder, right-click on the DoorArmrest Assembly From Split 

assembly document and select the  Mold command. 

• Select Blank Template and click on  to confirm. 

• From the Project tree, rename the new mold document My first mold. 

Repositioning the core and cavity blocks 

By default, during inclusion, TopSolid positions the assembly's opening frame (from the Split) on the absolute frame 
of the new mold document. In this exercise, we want to position the center of the core and cavity blocks and a face 
given on the mold document's absolute frame. 

• From the Entities tree, open the Frames folder, right-click on Absolute Frame and select the  Show 
command. 

• Right-click on one of the assembly shapes and select the  Edit Positioning command from the Core Cavity 
Blocks Inclusions section. 

• Right-click on the Frame on Frame 1 positioning constraint’s label and select the  Delete command. 

• From the Assembly tab, select the  Plane on Plane command and pin the dialog box using the  icon.  
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• In the Source plane field, click on the  icon and select the  Midplane command. Select the front and 

back faces as shown below, then click on  to confirm. 

 

• In the Destination plane field, select Absolute YZ Plane from the drop-down list. 

• For the second Plane on Plane constraint, repeat the previous steps to constrain the middle plane of the left 
and right side faces with the absolute XZ plane. 

• For the last Plane on Plane constraint, select the face as shown below and constrain it with the absolute XY 
plane. 

 

• Confirm positioning 1. 
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Including a manufacturer's standard mold base 

• Make sure that the manufacturer's library is referenced in the project. To do this, open the References node in 
the Project tree and make sure that the TopSolid Meusburger Tooling library is available. If not, right-click on 

References, select the  Reference Library command and select the TopSolid Meusburger Tooling library. 

• From the Mold tab, select the  Mold Base Inclusion command. 

The parameters on the left of the dialog box are the general parameters of the mold base. 

• Adjust the parameters as shown below. 

 

The parameters on the right of the dialog box are the parameters for a plate of the mold base. You can select the 
plate from the Component drop-down list. 

 

Note: You can also select the plate by clicking directly on the plate in the graphics area.  



Single-cavity Mold  TopSolid'Mold 

6   TopSolid 

• Adjust the following parameters for each plate. 

• Click on  to confirm. 

 

Note: At any time you can return to the mold base dialog box by editing the command. From the Operations tree, 

you only have to right-click on the Mold Base Inclusion operation and select the  Edit command. 

Viewing the sets 

TopSolid automatically creates three sets and its subsets in a mold document: 

- the Mold set contains the A Side and B Side subsets; 
- the To Mold set contains the plastic part(s); 
- the Categories set contains subsets of the mold elements such as the blocks, the mold base, etc. 

  

Component Family Height Width Material 

Top Clamp Plate F15 46mm - 1.1730 

A Plate F50 46mm - 1.1730 

Third Core Cavity Plate F50 96mm - 1.1730 

B Plate F50 66mm - 1.1730 

Bottom Backing Plate F60 46mm - 1.1730 

Risers F70 96mm 62mm 1.1730 

Ejector Retaining Plate F80 17mm  1.1730 

Ejector Base Plate F85 22mm  1.1730 

Bottom Clamp Plate F15 46mm - 1.1730 
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These sets and subsets can be used in the bills of materials and drafting documents. It can be interesting to filter, 
hide or display them in order to facilitate certain tasks. 
These sets and subsets are available in the Entities tree's Sets folder. 

 

They are also available in the Parts tree. As well as being able to view the sets and parts, you can also filter the 
elements by function (plate, ejector base plate, guide pin, screw, inserts, etc.). 

 

The icons on the bottom right of the graphics area allow quicker access to the main sets. 
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Creating a cavity process 

The  Cavity Process command quickly removes the material of the core and cavity blocks from the mold base's 
plates, and allows you to directly apply fillets/chamfers onto the vertical edges of the blocks. 

• Select the  Cavity Process command and adjust the following parameters. Make sure you select the 
Rectangular model document. 

 

• Click on  to confirm. 

Note: From the Parts tree, you can filter and hide the A Side subset to view the process result. 

 

• Hide the mold base. To do this, click on the  Hide/Show Mold Base icon at the bottom right of the graphics 
area. 
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Creating the heels 

• From the Mold tab, select the  Heel command and adjust the parameters as indicated below: 

- Heel: Select the cylindrical insert of the cavity block as the part to modify. 
- Section: Check the Model document box and select the Cylindrical model. 
- Drivers: Enter Diameter = 35mm and Process Diameter = 36mm. 
- Height: Enter Heel = 12mm. 
- Top Edges: Heel = 1mm, Process = 0.5mm. 
- Blend Edges: Heel = 0.5mm, Process = 1mm. 

 

 

Note: You can create the sketches on the fly or select existing profiles for the heel and process sections using the 
special inputs. 
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• Create heels on the cylindrical inserts of the core block by adjusting the following values. 

 

First cylindrical insert on the core block: 

• Drivers: Adjust the heel diameter to 30mm and the process diameter to 31mm. 

• Height: Adjust the height to 12mm. 

• Top and Blend Edges: Enter the same values as for the first heel. 

Second cylindrical insert on the core block: 

• Drivers: Adjust the heel diameter to 10mm and the process diameter to 11mm. 

• Height: Adjust the height to 12mm. 

• Top and Blend Edges: Enter the same values as for the first heel. 

Note: If the frame is not created automatically, you can create it on the fly using the special inputs. In this exercise, 

you can use a  frame on plane. 
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• Create the following sketch on the top face of the cavity block's center insert, then confirm the sketch. This 
sketch represents the shape of the heel. 

 

• Create a second sketch as shown below on the same top face of the cavity block's center insert, then confirm 
the sketch. This sketch represents the shape of the process. 

Note: You can use the projection in  Path between two edges mode. 
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• Create a new sketch as shown below on the top face of the cavity block's rectangular insert, then confirm the 
sketch. This sketch represents the shape of the heel. 
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• Create a second sketch as shown below on the same top face of the cavity block's rectangular insert, then 
confirm the sketch. This sketch represents the shape of the process. 

 

Note: We recommend that you rename the previously created sketches to identify them more easily for future 
manipulations. 
To do this, open the Entities tree's Sketches folder and rename the four previously created sketches. For example: 

- Center insert heel sketch 
- Center insert process sketch 
- Rectangular insert heel sketch 
- Rectangular insert process sketch 

• From the Mold tab, select the  Heel command and adjust the parameters as indicated below. 
Select None for the top, vertical and blend edges. 
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• Create a heel on the last insert of the cavity block using a rectangular profile. 
Select None for the top, vertical and blend edges. 

 

•  Save the mold document. 

  



TopSolid’Mold  Single-cavity Mold 

TopSolid   15 

Creating the bill of materials 

• Right-click on the mold document's tab and select the  Bill of Material command. 

• Select the Id.Qty.Des.PN.Mat.Mass template from Standard Templates - United States, then click on  to 
confirm. 

•  Confirm the default assembly document. 

Note: You can create a bill of materials by sets/subsets by selecting the Sets option. 

 

• Add the following two columns: Manufacturer and Manufacturer Part Number. To do this, select the 

 Columns command from the Bill of Material tab. From the list on the left, select the Manufacturer 

(General) and Manufacturer Part Number (General) variables and click on the  icon to move them to the 
list on the right. 

• Click on  to confirm the operation. 

 

•  Save the bill of materials.  



Single-cavity Mold  TopSolid'Mold 

16   TopSolid 

Creating the drafting document 

A Side and B Side views 

• Right-click on the mold document's tab and select the  Drafting command. Select the Assembly A1 ISO 
Landscape template from Standard Templates - United States. 

Note: The  Tooling View command is automatically displayed and you can select the set to be added. This 
command is available in the Mold tab. 

• Check the Sets box, then open the Mold set and check the B Side subset. 

 

• Place the view in the drawing and click on  to confirm. 

You can then create an auxiliary view for the A side view. 

• Uncheck the B Side subset and check the A Side subset. 

 

• Place the view in the drawing and click on  to confirm. 

•  Close the dialog box. 
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Detailing the views 

• Right-click on the main view, select the  Automatic Axes command, and then click on  to confirm. 
Repeat the operation for the auxiliary view. 

• For each view, select the  Automatic Composite Dimensions command from the Detailing tab and adjust 
the parameters as shown below. 
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View with custom orientation 

• From the Mold tab, select the  Tooling View command. 

• Check the Sets box, then open the Mold set and check the B Side subset. 

 

• Place the view in the drawing, regardless of orientation. 

• From the View tab, deactivate the  Snapped Camera option located on the right of the icon bar. 

 

• Use the mouse wheel to orientate the view as you wish. You can also adjust the visibility of the edges and the 
render mode. 

• Click on  to confirm the operation. 

• Repeat the previous operations for the A side. 
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Inserting the bill of materials and automatic indexing 

• From the Project tree,  drag and drop the BOM document into the drafting document. 

• In the Set field, select Main Set from the drop-down list. 

• In the First point or segment field, click directly on the title block's upper line in the graphics area. 

 

• Click on  to confirm the operation. 

• From the Detailing tab, select the  Automatic BOM Index command. Select the B Side view. 

• Click on  to confirm the operation. 

• Repeat the previous operation for the A side. 
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Multi-cavity Mold 

In this second part of the guide, you will learn how to manage a multi-cavity mold and insert various components 
using the processes, wizards and families. 

Concepts addressed: 

- Including an assembly resulting from the Split process 
- Multi-cavities and union 
- User mold base 
- Cavity process 
- Positioning pins 
- Inserting components (pins, screws, flange sets…) 
- Cooling circuit 
- Runner circuit 
- Drafting and bill of materials 
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Including an assembly resulting from the Split process 

Including the assembly in a new mold document 

• From the Project tree, open the Ex02 - Multi-cavity mold folder, right-click on the Plug assembly document and 

select the  Mold command. Select Blank Template and click on  to confirm. 

• From the Project tree, rename the new mold document My second mold. 

Repositioning the core and cavity blocks 

As in the previous exercise, during the inclusion, TopSolid positions the assembly's opening frame (from the Split) 
on the absolute frame of the new mold document by default. 
In this exercise, we want to position the core and cavity blocks differently. 

• From the Entities tree, open the Frames folder, right-click on Absolute Frame and select the  Show 
command. 

• Right-click on one of the assembly shapes and select the  Edit Positioning command from the Core Cavity 
Blocks Inclusions section. 

• Right-click on the Frame on Frame 1 positioning constraint's label and select the  Delete command. 

• From the Assembly tab, select the  Plane on Plane command and pin the dialog box using the  icon. 

- Source plane: Select the side face as shown below. 
- Destination plane: Select Absolute YZ Plane from the drop-down list. 

 

• For the second Plane on Plane constraint, do the following: 

- Source plane: Select the rear face as shown below. 
- Destination plane: Select Absolute XZ Plane from the drop-down list. 
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• For the last Plane on Plane constraint, do the following: 

- Source plane: Select the face of the parting line as shown below. 
- Destination plane: Select Absolute XY Plane from the drop-down list. 

 

The absolute frame will represent the mold zero point. It is located this way because we will subsequently repeat 
the core and cavity blocks to make a total of four. 

 

• Confirm positioning 1. 
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Creating the heel on the insert 

Heel and process sketches 

• Create a frame on the core block's bottom face, with the origin centered on the insert. 

 

• Draw the following new sketch on the XY plane of the previously created frame. To do this, select the Half Moon 
standard profile and adjust the following values: 

- Circle Diameter: 32mm 
- Distance Between Circle Center and Flat: 3mm 

 

• Draw the following new sketch on the same XY plane. Select the Obround standard profile and adjust the 
following values: 

- Internal Length: 21mm 
- Thickness: 29.5mm 
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• From the Mold tab, select the  Heel command and adjust the parameters as indicated below. 

 

• Click on  to confirm the operation. 
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Creating the multi-cavities 

• From the Mold tab, select the  Multi Cavity command. 

• Click on the  icon to select the pattern to be used. 

There are several repetition modes: circular, linear, symmetrical, etc. 
For this exercise, we will choose the core cavity block pattern which allows you to perform a linear matrix repetition 
with automatic calculation of the step. You only have to indicate the direction of repetition for the axes and the 
total count of core and cavity blocks on each axis. 

• Select  Core Cavity Block Pattern and adjust the following parameters. 

  

• Click on  to confirm the operation. 

• Complete the multi-cavity dialog box as shown below. 

 

Note: The Monoblock cavity block and Monoblock core block options allow you to unite the cavity blocks into one 
single block, and unite the core blocks into another single block. 
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Including the user mold base 

• From the Mold tab, select the  Mold Base Inclusion command. 

• Adjust the parameters as shown below. 

 

Reminder: The parameters on the right of the dialog box are the parameters for a plate of the mold base. 
You can select the plate from the Component drop-down list. 

 

You can also select the plate by clicking directly on the plate in the graphics area.  
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• Adjust the following parameters for each plate. 

Component Family Thickness Width Material 

Top Insulate Plate Empty Plate    

Top Clamp Plate Clamp Plate 36mm - Steel 

Top Support Plate Support Plate 36mm - Steel 

A Plate 2 Empty Plate    

A Plate Core Cavity Plate 96mm - Steel 

B Plate Core Cavity Plate 96mm - Steel 

B Plate 2 Empty Plate    

Bottom Support Plate Support Plate 56mm - Steel 

Rails Rails 115mm 62mm Steel 

Ejector Retaining Plate Ejector Retaining Plate 27mm - Steel 

Ejector Base Plate Ejector Base Plate 36mm - Steel 

Bottom Clamp Plate Clamp Plate 36mm - Steel 

Bottom Insulate Plate Empty Plate    

• Click on  to confirm. 

 

Reminder: At any time you can return to the mold base dialog box by editing the command. From the Operations 

tree, you only have to right-click on the Mold Base Inclusion operation and select the  Edit command. 
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Creating the cavity process 

As in the previous exercise, we will apply the  Cavity Process command only once, for the core and cavity blocks. 
You can apply the command several times if the values are not the same for both core and cavity blocks. 

• Hide the mold base by clicking on the  icon in the graphics area. 

• Select the  Cavity Process command. Select the Rectangular model, then enter 25mm for the block radius 
and 20mm for the process radius. 

 

• Click on  to confirm the operation. 

•  Show the mold base.  
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Positioning pins 

Positioning on point 

• To help you position the pin, hide the A Side subset by clicking on the  icon in the graphics area. 

• Select the core block, the first insert and the ejector retaining plate, then right-click and select the  Show 
Only command. 

 

Only three parts remain visible on the screen. In addition, two new icons have appeared at the top right of the 
graphic area. 
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• From the Mold tab, select the  Pin command. 

• For the positioning, select the  Point mode, then select the part's circular edge to detect the center of the 
part. 

• Click on the  Dimensioning icon and enter a diameter >= 6mm. TopSolid will select the most appropriate 
component. 

 

Note: The positioning plane is automatically detected on the top face of the ejector base plate. However, if you 
want to change the height position, trim with other elements or force a keying on the pin, you can modify the 
parameters in the Positioning, Keying or Trimming options. 

• Once the command has been confirmed,  confirm the default process. 
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In the Operations tree, we find the pin creation operation and the process creation operation. 

 

Note: It is recommended to defer the pin processes at the end of the design in order to accelerate the regeneration 
times due to the synchronization between the different parts of the tooling. 

• Delete the pin process. 

• From the Assembly tab, deactivate the  Automatic Process mode. 
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Positioning on sketch 

• Create the following sketch on the absolute XY plane. 

• Reposition the sketch's origin in the center of the pin. 

• Enable the dynamic symmetry with respect to the X axis of the sketch. 

 

• Create a circle of Ø8mm at the intersection of the sketch's Y axis and the Ø92mm circle. 

• Enable the double dynamic symmetry with respect to the X and Y axes of the sketch. 

 

• Create a circle of Ø10mm at the intersection of the 45° segment and the Ø92mm circle as shown below. 

 

• Confirm the sketch. 
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• From the Mold tab, select the  Pin command. 

• For the positioning, select the  Sketch mode and select the previously created sketch. 

• In the  Keying option, select Automatic as the keyed type. 

 

Note: TopSolid automatically assigns the pin diameters according to the drawn circles. 

• Click  to confirm. 

• Edit pin 3 and reverse the keying direction to obtain two identical Ø8mm pins. 

• Repeat the procedure for pins 1 and 2. 
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Repeating the pins 

• From the Construction tab, select the  Repetition command and select the pins to be repeated. 

 

• For the pattern, reuse pattern 1 (core cavity block pattern) available in the drop-down list. 

• Add four pins as shown below (center distances X=310, Y=550, pins Ø16mm). 
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Creating the processes 

Note: The guiding length of the pins in the blocks is calculated in relation to the maximum point of the pin (by 
default, 1.5 times the diameter). 

There are three ways to assign processes to the pins. 

1- Defining a process on a pin and reproducing it on a group 

• From the Parts tree, display only the Ø8mm pins. 

Note: Due to the shape at the end of the pin, the effective boring length should be 22mm. 

• From the Modeling tab, select the  Use Process command. 

• Select one of the pins. 

• In the Optional Drivers tab, enter a boring length (X) of 22mm. 

•  Confirm the process. 
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• From the Modeling tab, select the  Reproduce Process command. 

• Check the Create processes box. 

• Select the previously used Ø8mm pin as the reference occurrence, then select the other Ø8mm pins as 
additional occurrences. 

 

•  Confirm the process. 

2- Creating a process on several pins 

• From the Parts tree, display only the Ø10mm pins. 

Note: Due to the shape at the end of the pin, the effective boring length should be 18mm. 

• From the Modeling tab, select the  Create Processes command. 

• From the Parts tree, click on the folder containing the Ø10mm pins and click on  to confirm. 

• In the Optional Drivers tab, enter a boring length (X) of 18mm. 

• Check the Apply to all box. 

•  Confirm the process. 
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3- Creating a process on the pins without process 

• From the Parts tree, display all pins. 

• From the Modeling tab, select the  Create Processes command. 

• In the dialog box, click on the Detect occurrences without process button and click on  to confirm. 

•  Confirm the process. 

 

• From the Operations tree, select all the pin processes and create a folder named Pin processes. 
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Including standard components from TopSolid libraries 

Search and customization 

Reminder: The library in which you are searching for your components must be referenced in your project. 

Method 1: Creating a quick search 

• Select the quick search command by clicking on the  icon at the top right of the screen. 

• Adjust the following criteria to search for a standard guide pin, then click on the  button to start the 
search. 

 

The Search Results dialog box opens. 

 

This method is fast but requires you to fill in the search criteria each time you change components. 
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Method 2: Creating a search document 

This method is useful if you are often searching for the same components. 

We will create a search document for the guiding elements: Meusburger components E 1010, E 1100, E 1110 and 
E 1160. 

• Open the Searches tree by right-clicking on the Project tree's black title bar and selecting  Searches. 

 

• From the Searches tree, right-click on My Searches to create a new search. 

 

• Select Blank Template. 

• Select only the Family type from the Type drop-down list, then click on the Apply button. 
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• Search in Current project. 

• Click on the  Search in project references icon. 

• Click on the area below the Property field and select General > Name. 

 

• Click on  to confirm. 

• In the Operator field, select Contains. 

• In the Value field, enter E 1010. 

 

• Add three new search lines for the E 1100, E 1110 and E 1160 components. 

 

• Click on the  Refresh icon to test. 

The result is displayed as a list. 

 

• Rename the search document Meusburger guides. 

•  Save and close the document.  
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• To create a new Meusburger screws (E 1200, E 1240) search, copy and paste the Meusburger guides search 
and rename it Meusburger screws. 

• Open the Meusburger screws search. Replace the values in the first two lines and delete the unnecessary lines 
as shown below. 

 

 

•  Refresh, then  save and close the document. 

• Once all the tests have been performed,  check the two searches into the vault and  validate them. 

To facilitate the insertion of these components without using the Searches tree, we will create two icons 
corresponding to each search that will appear in the icon bar at the bottom of the graphics area. To do this, you 
have to create and enable a custom menu to modify the content of the icon bars. 

• From the Tools tab, select the  Menu command. 

• In the dialog box, click on the Add button, enter a name for the menu, then  confirm twice. 
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• From the Tools tab's icon bar, select the previously created menu. 

 

• From the Tools tab, select the  Customize command. 

• In the Add a search to execute area of the dialog box, click on the  button next to the Search document 
field and select the Meusburger guides document from the list. 

 

• Click on the  button next to the Drag-and-drop icon field and assign an icon to your search. You can select 
an icon from the list or include your own icons in PNG format. Icons in PNG format are provided with the project. 

• Drag and drop the icon at the bottom center of the graphics area. 

 

• Repeat the operation for the second search, then click on  to confirm. 

This customization will only be assigned to the mold documents. You can repeat this operation for other types of 
documents (part, assembly, etc.) if necessary. 

We will now use the previously created searches to include these components in the mold.  
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Guide pins 

We will insert two guide pins using the Guide Pin wizard. 

 

• Click on the Meusburger guides search icon. 

The Search Results dialog box opens. 
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•  Drag and drop the E 1010 component into the graphics area and adjust the following parameters to position 
the first guide pin. 

• Select the Guide Pin wizard. The positioning face will be the top face of the top plate. 

• Select the absolute frame as the reference frame and enter the coordinates as shown below. 

• In the  Dimensioning option, fill in the fields as shown below, then click on  to confirm. 
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Note: If you want to change the diameter and length clearances, edit the Process operation in the Operations tree 
and modify the desired values in the Drivers section. 

 

• Include the same component using the Guide Pin wizard and the E 1010/24 - 36/115 code, then position the 
guide pin on the top face of the lower support plate. Reverse the frame direction if necessary. Select the 
absolute frame as the reference frame and enter the coordinates as shown below. 
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Guide bushes 

We will now insert four guide bushes and a centering bush using the Guide Bush wizard. 

 
1: E 1110 32-36 
2: E 1110 32-96 
3: E 1100 32-96 
4: E 1100 24-27 
5: E 1160 42-160 

• To help you position the component, hide the first guide pin and the top clamp plate or  show only the 
support plate. 

• Relaunch the Meusburger guides search if necessary. 
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• Drag and drop the E 1110 component into the graphics area and adjust the following parameters to position 
the first guide pin. 

• Select the Guide bush wizard. 

• In the Dimensioning option, select the hole in the plate as the guiding diameter and the plate as the guide bush 
length element. Hover the mouse cursor over the guide pin's drilling so that TopSolid automatically detects the 
hole center. 
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• After confirming the wizard,  confirm the default process, then select the Housing process for the circlip in 
the second dialog box. 
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• To help you position the next component, leave the top clamp plate hidden and hide the second support plate 
as well as the created bush. 

 

• Drag and drop the E 1110 component into the graphics area. Select the Guide bush wizard. 

• Repeat the same operations as for the previous bush. 
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• To help you position the next component, hide the bottom support plate. 

 

• Relaunch the Meusburger guides search if necessary. 

 

• Drag and drop the E 1100 component into the graphics area and adjust the following parameters to position 
the third guide pin. 

• Select the Guide bush wizard. 

• In the Dimensioning option, select the hole in the plate as the guiding diameter and the plate as the guide bush 
length element. 

• For the positioning, hover the mouse cursor over the drilling to detect the hole center. 

 

• After confirming the wizard, check the Centering Process Through box in the Use Process dialog box.  
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• To help you position the fourth screw, hide the ejector base plate and the guide pillar as shown below. 

 

• Insert the same component using the Guide bush wizard. 

• In the Dimensioning option, select the hole in the ejector retaining plate as the guiding diameter and the 
ejector retaining plate as the guide bush length element. Hover the mouse cursor over the drilling to detect 
the hole center. 
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• After confirming the wizard, check the Centering Process Through box in the Use Process dialog box. 

 

• Relaunch the Meusburger guides search if necessary. 
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• Drag and drop the E 1160 component into the graphics area and adjust the following parameters to position 
the centering bush. 

• Select the Guide bush wizard. In the Dimensioning option, select the hole in the bottom backing plate as the 
external diameter and the rail as the element to center. Create a frame on plane as the positioning frame using 
the external plane of the clamp plate and a center point on one element of the guide pillar as the reference. 

 

• In the Use Process dialog box, adjust the following parameters. 
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Fixing screws 

We will now insert four standard screws using the Screw Automatic Buried Head wizard. They will then be repeated 
using a double symmetry. 

  

• Click on the Meusburger screws search icon. 

 

• Drag and drop the E 1200 component into the graphics area and adjust the following parameters to position 
the first screw. 

• Select the Screw Automatic Buried Head wizard. In the Dimensioning option, adjust the minimum diameter 
to 16mm and select the B plate as the last element to fix. The positioning face will be the bottom face of the 
B plate. Select the absolute frame as the reference frame and enter the coordinates as shown below. 
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After confirming the wizard, the process dialog box appears. Various processes are possible for this type of 
component. 

• Select Tapped hole. 

 

• To help you position the next component, hide the bottom clamp plate. 

 

• For the second screw, drag and drop the E 1200 component into the graphics area to fix the ejector retaining 
plate and the ejector base plate. Enter the following values for the dimensioning and positioning. 

 

• After confirming the wizard, select the Tapped hole process in the Use Process dialog box.  
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• To help you position the next component, hide the following mold base elements. 

 

• For the third screw, drag and drop the E 1200 component to fix the core block and the B plate. Enter the 
following values for the dimensioning and positioning. 

 

• After confirming the wizard, select the Tapped hole process in the Use Process dialog box. 
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• To help you position the last screw, hide the first two plates on the A side. 

 

• For the fourth screw, drag and drop the E 1200 component into the graphics area to fix the cavity block and the 
A plate. Enter the following values for the dimensioning and positioning. 

 

• After confirming the wizard, select the Tapped hole process in the Use Process dialog box. 
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Repeating the components 

• For the next manipulation, hide all the elements except the last inserted components: guide pins, guide bushes 
and screws. 

• From the Construction tab, select the Repetition command and select the components to be repeated by 
symmetry: the screws, the guide pins and the guide bushes. 

• For the pattern, select  Symmetrical Pattern using the  special inputs. Adjust the following parameters 
for the double symmetry. 

 
 
 
 
 
 
 
 
 
 
 
 

• Click  to confirm. 
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Difference between the process repetition modes 

The Assembly mode is safer but slower and the part contains as many basic operations (no repetition in each 
impacted part). This mode is recommended when the repetition impacts new parts. 

The Parts mode has two options (repetition in each impacted part): 

- Replay operations: This option is useful when the faces to be operated are not the same as the first 
component. 

- Fast repetition: This option is useful when the faces to be operated are the same. 

You must first define the option in the Tools > Options > Assembly > Process Repetition > Show Dialog command. 

 
• From the Entities tree, open the Patterns folder and rename pattern 2 Double Sym XZ - YZ. 
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Including user components 

Support pillars 

We will insert four support pillars on the ejector set whose positioning face will be the bottom face of the clamp 
plate. 

  

• From the Project tree, open the Ex02 - Multi-cavity mold > A - User library > 1 - Pillar support folders, select the 
Pillar support family document and drag and drop it into the graphics area. 

• Select the absolute frame as the reference frame, position the first support pillar on the clamp plate's bottom 
face, then enter the following coordinates. 

• For the plate thickness, click on the  icon, select the Associative value option and click on an edge defining 
the thickness of the clamp plate. For the pillar height, proceed in the same way, this time clicking on an edge 
defining the height of the rails. 
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•  Confirm the proposed processes (pillar+screw). 

• Include the same component for the second support pillar by adjusting the diameter to 50mm, then repeat the 
previous operation for the plate thickness and the pillar height. 

 

• Using a  circular pattern, perform a repetition of the two support pillars around the Z axis by adjusting the 
total number to 2. 
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Ejector rod 

The positioning face of the ejector rod will be the ejector plate's bottom face. 

 

• To help you position the next component, only display the necessary elements to position this component. 

• From the Project tree, open the Ex02 - Multi-cavity mold > A - User library > 2 - Ejector rod folders, select the 
Ejector rod family document and drag and drop it into the graphics area. 

• Select Absolute frame as the reference frame, then position the component in the center of the mold and 
against the bottom face of the ejector plate. Reverse the frame direction if necessary. Create a distance 
parameter for the rod length. 

 

After confirming the wizard, the process dialog box appears since several choices are possible. 

• Select the Ejector rod process. 

Note: You can assign this default process to this component by moving it to the project's Favorites folder.  
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Spacer 

• Hide the clamp plate to make it easier to position the component. 

• From the Project tree, open the Ex02 - Multi-cavity mold > A - User library > 3 - Buffer plate folders, select the 
Buffer plate family document and drag and drop it into the graphics area. 

• Select the E 1505/20 code and select Absolute frame as the reference frame. 

• Position the component against the ejector plate's bottom face and adjust the following parameters. Reverse 
the frame direction if necessary. 

 

•  Confirm the default process. 

• Perform a repetition by double symmetry by reusing the Double Sym XZ - YZ pattern. 
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Ground puller bolts 

We will insert two shoulder bolts that will be used to create several collinear movements with delay in order to 
break the sprue as the mold opens. These bolts will be repeated by double symmetry. 

 

• Click on the Meusburger screws search icon. 
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• Drag and drop the E 1240 component into the graphics area, then position it against the external face of the 
support plate and adjust the following parameters. Select the clamp plate as the element containing the screw 
head. 
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• In the process dialog box, adjust the following parameters. 
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• Include the same component against the top face of the A plate, then adjust the following parameters. Select 
the clamp plate as the element containing the screw head. 
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• In the process dialog box, adjust the following parameters. 

 

• From the Construction tab, select  Repetition, then select the shoulder bolts and perform a double 
symmetry by reusing the Double Sym XZ - YZ pattern. 

• Modify the color of the components via the Parts tree. 
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Locating ring 

• Display the top clamp plate again. 

• From the Project tree, open the Ex02 - Multi-cavity mold > A - User library > 5 - Locating ring folders, select the 
Locating ring assembly document and drag and drop it into the graphics area. 

• Position the component against the top face of the clamp plate and centered on the mold. 

 

• After confirming the wizard, select the default processes. 
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Lifting eye bolt 

• From the Project tree, open the Ex02 - Multi-cavity mold > A - User library > 6 - Eye bolt folders and drag and 
drop the Eye bolt M16x27 part document into the graphics area. 

• Position the component against the side face of the B plate as shown below. You can calculate the center of 

mass using our tool for analyzing physical properties that can be accessed from the Analysis tab >  Physical 
Properties. This point must be calculated at the end of the mold design. 

 

If you want to position a lifting eye bolt on the A side and B side, you have to select the parts of the B side set, and 
then select those of the A side set. You will then have three centers of mass: one for the whole mold and two for 
the fixed and movable parts of the mold. 

A new operation is created in the Operations tree. 

Note: If you add a new part, you need to move this operation above this new inclusion in order to recalculate the 
new center of mass. 

A center of mass point is created in the Entities tree. 
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• To position the lifting eye bolt, create a frame on face and projected point on this face. 

 

 

•  Confirm the default process. 

•  Save the document.  
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Creating the cooling circuit 

The cooling circuit is based on a 3D sketch. Before continuing with the current mold, we will create a cooling circuit 
using a simple example. 

• Open the 3D Sketch mold document from the Ex02 - Multi-cavity mold > B - 3D sketch for cooling and runner 
circuits folders. 

Configuring the cooling circuit 

• Hide all parts except the cavity block and the A plate. 

• To better view the circuit, adjust the transparency of both parts to 80%. 

• From the Mold tab, select the  Cooling Circuit command and fill in the dialog box as shown below. The parts 
to be selected will be those affected by the cooling circuit. Enter a drilling diameter of 8mm. 

 

The  Style option allows you to manage the different settings of the cooling circuit using a style that can be 
reused at any time. 

• Click on the  Style icon, click on the  icon and select  Cooling Circuit Style. 

• Rename the style if necessary, then click on the Edit button. 
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The Cooling Circuit Style dialog box opens. 

 

• From the Drillings tab, check the Attribute box to enable the different settings and adjust the following 
parameters. 

 

Note: The cooling components (plugs, fittings, seals, etc.) can be placed automatically by checking the 
corresponding boxes in the Automatic components field.  
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• From the Baffle lines tab, check the Attribute box to enable the different settings and adjust the following 
parameters. 

 

• From the Circuit color tab, adjust the color of the cooling circuit if necessary. 

 
  



TopSolid’Mold  Multi-cavity Mold 

TopSolid   75 

• From the Plugs, Fittings, Seals and Baffles tabs, adjust the following parameters. 
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•  Confirm all the cooling circuit style's dialog boxes. The style is created in the Styles > Cooling Circuit Style 
folders of the Entities tree and can be edited at any time. 

Note: It may make sense to define your cooling circuit styles in a mold document template to save you from 
recreating them each time. 

• In the Cooling Circuit command, enable the  Baffle lines option and adjust the diameter to 12mm. The 
reference plane is the starting face for the drillings. If you select the block first, the face in contact with the 
plate will be automatically selected. If necessary, you can change the face by hiding the core cavity plate for 
easy selection. 

 

•  Confirm the cooling circuit. 
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Creating the 3D sketch 

• Right-click on the face as shown below and select the  View Along Normal command or press N on your 
keyboard. 

 

• Leave the face selected, right-click in the graphics area and select the Set Input Plane command. 

• From the 3D Sketch tab, select the  Contour command and click on the face as shown below. 

 

Note: You should avoid hooking an existing geometry when drawing the lines. 

• In the sketch settings, select the  Filter External Geometries mode. 
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• Put the view into perspective by clicking on the  icon and change the orientation of the frame by pressing 
Ctrl + Space bar as shown below. 

 

• Once the orientation is selected, select  View Sketch From Top and continue the sketch by drawing two 
lines as shown below. 

 

Note: Put the view into perspective and change the orientation of the frame again by pressing Ctrl + Space bar. 
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• Once the orientation is selected, select  View Sketch From Top to continue the sketch. If necessary, rotate 
the view using the arrow keys on the keyboard. 

 

• Add a coincidence constraint between the start point and end point with the starting face. 

Note: To only display the cooling sketch, you only have to click on the  Hide Cooling icon at the top right of the 
graphics area. 

• Add the alignment, equality and dimensioning constraints as shown below. For the dimensions, use the faces 
and planes with the elements of the 3D sketch. 

 



Multi-cavity Mold  TopSolid'Mold 

80   TopSolid 

• To define the exit, right-click on the segment or cylinder of the exit drilling and select the  Set As Exit 
command. 

 

• At the top right of the graphics area, click on the  Safety Margin icon to enable the dynamic collision 
detection with a margin of safety. 
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• Adjust the dimension to 50mm to remove the invalid areas. 

 

Modifying the cooling circuit and adding baffle line 

• Right-click on the desired starting point or segment and select Set Input Plane. 

• Draw the two lines shown below. 

Note: The first point gives the direction of the drilling. 
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Modifying the drillings 

If some through holes are facing the wrong direction, you need to edit the drilling by double-clicking on the cylinder 
of the drilling to be modified, and then double-click on the direction arrow. 

Here we want all drillings to be on the same face of the block, i.e. the face on the entry/exit side. 

 

Adding baffle line 

• Create the middle point of the last two segments. 

• Right-click on the previously created point and select the  Create Baffle Line command. 

The drilling is automatically added with the values you previously entered, and the blade and plug are positioned. 
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Inserting components in the cooling circuit 

We will now insert plugs in the cooling circuit. 

• Right-click on the line where you want to position the plug and select the  Include Component command. 

• Select a Meusburger E 2072 plug. 

 

• Position the plug on the segment and adjust the dimension by adding a centering constraint for example. 

In the example below, the plugs are centered between the two segments. 
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Creating the cooling process 

To ensure performance, the cooling circuit actually creates cylindrical "positive" shapes. The drillings are not 

calculated. You can then start this calculation when you want using the  Cooling Circuit Process command. 

• From the Mold tab, select the  Cooling Circuit Process command. 

 

•  Confirm the default circuit. If there are several cooling circuits, select the one you want in the drop-down 
list. 

The process dialog box appears for each type of component. 
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•  Confirm the default process. 

 

Cooling symmetry 

• Right-click on the existing circuit and select the  Copy command. 
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• Then select the  Paste with Pattern command. 

 

 

• Edit the cooling sketch 2 and add the appropriate constraints. 
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Derivation for modification 

When using supplier's standard components, some of these may be modified with drilling or pocket operations, or 
may be shortened. Therefore, they must be declared as derived parts before any modification is made. 

• Display the E 1625 / 18 x 124 / 4 - Sprue Bush 0.5° with radius 15.5 component, then right-click on this 

component and select the Others >  Derive Part for Modification in the component section. 

Note: A new  Replacement operation is created in the Operations tree. 

• From the Modeling tab, select the  Trim command. Perform a trimming operation in relation to a plane 
whose part is the component to be trimmed and the plane is the face shown below. 

 

Note: If the derivation step is not performed by the user, TopSolid will do this automatically and will notify about 
it through a message. 
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Creating the runner circuit 

The runner circuit is based on a 2D sketch. TopSolid automatically projects the casting shape on the part. 

• Click on the  icon in the graphics area to hide the A side. 

Configuring the runner circuit 

• From the Mold tab, select the  Runner Circuit command. 

• Select the part that will be used as a support to project the runner circuit. 

• Click on the  Channels option, select the Full Round profile in the Section field, then adjust the overlap to 
0mm. 

• In the  Drivers option, enter a diameter of 4mm. 

• Click on  to confirm. 

Creating the 2D runner sketch 

• In the runner sketch, draw a line as shown below. 

 

• Confirm the runner sketch. 
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Creating the runner process 

To ensure performance, the runner circuit actually creates cylindrical "positive" shapes. The drillings are not 

calculated. You can then start this calculation when you want using the  Runner Process command. 

• Display the sprue bush component E 1625 / 18 x 124 / 4 - Sprue Bush 0.5° with radius 15.5. 

• From the Mold tab, select the  Runner Process command. 

• Leave the default circuit. If there are several runner circuits, select the one you want in the drop-down list. 

• Select the parts that will be affected by the material removal. 
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Inserting a user component: Gate 

• From the Project tree, open the Ex02 - Multi-cavity mold > C - Mold after cooling and runner circuits folders, 
and then open the My 2nd mold after cooling and runner circuits mold document. 

• Display the part to be injected, the A plate, the cavity block, as well as the points. 

• From the Visualization tab, select the  Cut by planes command. Select the absolute YZ plane, select the 

point on the part as the passing point, then click on  to confirm. 

• From the Mold tab, select the  Gate command. 

• Fill in the fields as shown below. 

 

• Click  to confirm. 
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•  Confirm the process. 

 

• Hide the gate. 
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Inserting a user component: Sprue puller 

• Show the plates on the A side. 

• From the Mold tab, select the  Pin command and fill in the dialog box as shown below. 

 

After confirming the wizard, the process dialog box appears. 

• Select the Cylindrical Pin process and disable the Manual mode. 
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Inserting a user component: Plug 

• From the Project tree, open the Ex02 - Multi-cavity mold > A - User library > 10 - Plug folders, select the Plug 

family document and  drag and drop it into the graphics area. 

• Adjust the following parameters. 

 

• After confirming the wizard, select the Cylindrical Thread Plug process and click on  to confirm. 

Repeating the components 

• From the Construction tab, select the  Repetition command and select the components to be repeated by 
symmetry: the sprue puller, the plug and the gate. 

• For the pattern, reuse the core cavity block pattern available in the drop-down list. 
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Creating the bills of materials 

We will create two bills of materials: the first will list the mold set and the second will list the parts for machining. 

First bill of materials 

• Right-click on the My 2nd mold after cooling and runner circuits mold document from the Project tree or on the 

document's upper tab and select the  Bill of Material command. 

• From Project Templates, select Mold BOM template. 

 

•  Confirm the default assembly using detailed representation. 

• From the Project tree, rename the document Complete Mold. 

Note: You can manually force the indexing of the parts by checking the Occurrence index box and entering the 
index value as shown below. The forced index then appears with a green background in the bill of materials. 
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Second bill of materials 

• Right-click on the My 2nd mold after cooling and runner circuits mold document from the Project tree or on the 

document's upper tab and select the  Bill of Material command. Select Mold BOM template. 

• For the proposed assembly, select the Sets option and check the Mold Base and Block categories. 

 

• Click  to confirm. 

• From the Project tree, rename the document Workshop Parts. 

Drafting the complete mold 

• Create a  Drafting document for the whole mold by adding the A Side and B Side views, the bill of materials 
of the complete mold, a cross section view, as well as the customized views with indexes. 
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Multiple draftings of the parts and drafting bundle 

The multi-drafting operation will allow you to draft a set of parts from a bill of materials, using one or more drawing 
templates. In our case, we will create multiple draftings of all the parts available in the Workshop Parts bill of 
materials. We will also generate a drafting bundle simultaneously that will group all the drawings into a single 
document. 

• Create a new  document in the Templates folder of the TopSolid'Mold Training D1 Project tree. 

 

• From the Advanced tab, select the  Drafting Bundle document type and select Blank Template. 

 

• Click on  to confirm. 

• Close the inclusion dialog box. 
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• In the graphics area, right-click on the frame and select the  Edit command. 

• Select the A0 portrait format. 

 

• Click on  to confirm. 

• From the Bundle tab, select the  Nesting Draftings command. 

• If necessary, adjust the margin values and the desired packing direction. 

• Leave the Draftings field empty. 

 

• Click on  to confirm. 

•  Save and close the document. 
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• Right-click on the My 2nd mold after cooling and runner circuits mold document from the Project tree or on the 

document's upper tab and select the  Multiple Draftings command. 

• Select the existing Workshop Parts bill of materials. 

 

• Click on  to confirm. 

• Adjust the following parameters. 

• From the Selections tab, for the first part, double-click in the Template column and select the A3H mold part 
template from the project templates. 

• Right-click in the same column and select Apply the template to this type. 
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• Click on the Options tab. Select the Specified folder option for the parts, then indicate the path as shown below. 

 

• Check the Create drafting bundle box. In the Drafting bundle template field, select the previously created 
bundle. 

 

•  Confirm the bundle selection. 

•  Confirm the creation of the multiple draftings. 
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The bundle document contains all the drawings on two pages. You can also create a drafting bundle manually. The 
procedure will be detailed in a future exercise. 

• Rename the bundle document Workshop parts. 
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Drawing Detailing 

Cooling circuit 

• Open the drawing for the A plate. 

• From the Mold tab, select the  Cooling Circuit Attributes command. 

If you are not in the exact mode, the following message appears. 

• Click on the Yes button. 

 

• Select the view to be modified. 

Note: You can create your own cooling circuit style. 

 

• Click on  to confirm. 
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Pin symbols 

• Open the mold drawing. 

• From the Mold tab, select the  Pin Symbol command. 

• Click on the desired view. 

Note: You can create your own symbol style. 
 

 

• Click on  to confirm. 
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Customizing the Processes 

In this exercise, we will customize the standard processes of TopSolid to better align them with your design habits. 

The purpose of this exercise is to manage the parameters of the tapped holes and the screw insertion. 

Summary of component’s documents 

A component can have a local process and wizard for a single use. 

If this component is to be replaced by another similar component, it is strongly recommended that you use a global 
function, wizard and process. 
TopSolid provides a number of global functions, processes and wizards, the most commonly used being the Screw 
function. 

 
Copying a standard process 

• Import the package named TopSolid'Mold Training D2.TopPkg. 

• Open the TopSolid Mechanical library. 

• Open the Components > Fasteners > Screws folders and  copy the Tapped Hole part process document. 
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• Create a  new library using a blank template and rename it My mold library. 

•  Reference the following libraries. 

 

• In the new library, create a folder named Drilling and tapping processes. 

•  Paste the part process document into the new folder. 

• Rename the document as you wish, My tapped hole for example. 
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Customizing the processes 

The goal is to manage the clearances on the spot facing diameter and the clearance hole of screws. 

• Open the My tapped hole process document. 

• From the Entities tree, open the Functions > Screw folders to display the list of the parameters required for a 
screw. 

 

Note: If you hover the mouse cursor over a description, the name of the parameter is displayed. 
In this exercise, dk is the head diameter parameter, k is the head height parameter and d is the nominal screw 
parameter.  
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• From the Construction tab, select the Parameters >  Table Parameter command and create the following 
two table parameters: 

- The jl parameter manages the clearance on the spot-facing diameter: 
o 0.50mm for the 5mm diameter; 
o 0.75mm for the 12mm diameter; 
o 1mm for the 20mm diameter. 

 
The interpolation type is used to handle the cases where the source value is different 
from the indicated values. With a left interpolation, the jl value will be: 

o 0.5mm if dk < 12mm; 
o 0.75mm if dk >= 12mm and < 20mm; 
o 1mm if dk >= 20mm. 

 
 
 
 
 
 
 
 
 
 
 
 
 
- The jt parameter manages the clearance on the clearance hole diameter: 

o 0.2mm for the 8mm diameter; 
o 0.5mm for the 10mm diameter. 
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These two new parameters are available at the top of the Operations tree. 

• From the Operations tree, move the jl parameter below the Facing operation which corresponds to the spot 
facing operation, then move the jt parameter below the Clearance Hole operation which corresponds to the 
clearance hole.  

 

• Always from the Operations tree, edit the Facing operation and replace the screw spot facing operation by a 
flat-bottomed blind hole with a diameter equal to dk+jl and a depth equal to h. 
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• Edit the Clearance Hole operation and replace the clearance hole operation by a blind hole with a diameter 
equal to d+jt and a depth equal to l. 

 

•  Save the My tapped hole document and  check it into the vault. 
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Defining a process rule according to your components 

The process rules are used to define the default process for each of your library's components. 

• Right-click on the My mold library name and create a new  Process Rules document from the Special tab. 
Rename the document My process rules. 

• Click on the Add button, select the Screw function from the list, and click on  to confirm. 

 

• In the Process column, select the My tapped hole and Tapped Hole processes. 

• In the Family column, select the E 1200 screw family for your process and the ISO 4762 screw family for the 
standard process. 

 

•  Save the document and  check it into the vault.  
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Testing the process rule 

• Right-click on the Favorites folder in your project and select the  Process Rules command. 

 

• Select your process rules named My process rules. 

 

Note: This must be done in your project template so that all new projects will benefit. 
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Customizing the screw insertion 

Sometimes, it is also useful to manage the screw insertion depth. When positioning screws, the Screw Automatic 
Buried Head wizard allows you to manage this value. 

• If you want to customize the insertion standard values to suit your habits, copy the wizard document from the 
TopSolid Mechanical > Components > Fasteners > Screws > Screw Automatic Buried Head library and paste it 
into your library. 

 

• Rename the wizard document My screw automatic buried head. 

• Open the wizard document and edit the Cheese Head Offset parameter. 
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Here, we want to drive this value based on diameter ranges: 

- from Ø3mm to Ø10mm, the clearance must be 0.5mm; 
- from Ø10mm to Ø20mm, the clearance must be 1mm. 

• Delete all values except 10mm and 20mm and select the Constant right interpolation. 

 

Note: You can also rename the parameters according to your terminology. 

•  Save the My screw automatic buried head document and  check it into the vault. 

Defining a wizard as a favorite 

If you always use the same wizard, you can set it as a favorite so that it can be used by default when inserting your 
component. 

• Right-click on the My Screw Automatic Buried Head wizard and select the Others >  Add to Favorites 
command. 

• Select the destination project. 

Warning: This must be done in your project template. 
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Test 

• Open a mold and position some screws. 

• Check the values. 

 

• Once all the tests and modifications are done,  validate the life cycle of all documents. 
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Importing and Creating Components 

In this exercise, we will import or create components and associate custom processes to them. 

Note: All documents in this exercise must be created in your own library. 

Summary of component’s documents 

 

A simple component is made up of a generic document, a local process and a local wizard. 

A parameterized component is made up of a generic document, a family, a local process and a local wizard. 

A global parameterized component is made up of a generic document, a function and a family. 

The wizard and the process are then driven by the function. Consequently, all the components that inherit the 
function also inherit the process and the wizard. 

Connector 

• From the TopSolid'Mold Training D2 project, open the Ex01 - Import and creation of components > Connector 

folders, then right-click on the HARTING 16E Bottom Base file and select the  Convert Document command. 

• In the Document type for assemblies field, select Part since, in this example, we do not want to create an 
assembly document. 
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• Create a new  Assembly document and rename it HARTING 16E. 

• Drag and drop the HARTING 16E Bottom Base part document into the assembly document you just created. 

• Select the  Quick Search command and enter screw%4762. 

• Drag and drop the Hexagon Socket Head Cap Screw ISO 4762 family into the assembly document. 

• Select the Screw in Hole wizard and the M4 x 12 code. 

• Position the screw in one of the holes as shown below. 

 

• Press the Esc key when the process dialog box appears. 

• Repeat this operation for the four holes or create a repetition by double plane symmetry. 

• From the Tools tab's drop-down menu, select the  Processing Parts command. 

• Select the four screws. 

 

•  Save the HARTING 16E assembly document. 
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Defining the symmetry plane 

To define this part as identical in a repetition by symmetry, we need to identify the symmetry plane both in the 
part document and the assembly document. Here, the symmetry plane is the XZ plane. 

• In the part document, open the Tools tab's drop-down menu and select the Symmetries >  Plane Symmetry 
command. Select Absolute XZ plane. 

 

• Repeat the previous operation in the assembly document. 

Defining the positioning wizard 

We want the connector to be positioned always in the same way, i.e. in the middle of the support face. Here, the 
absolute frame is the appropriate choice. 

• From the assembly document’s Entities tree, open the Frames folder, right-click on 

Absolute Frame and select the Others >  Publish Frame command. 

• Enter a description for this publishing.  
 
 

• Adjust the properties for the bill of materials, then  save the document. 

• From the Tools tab, select the  Create Wizard command. 

TopSolid creates a new Wizard document in the Project tree. 

• Rename this document HARTING 16E - Center. 

• From the Assembly tab, select the  Frame on Frame command. 

• Select the frame on the connector as the source frame and select Absolute Frame from the drop-down list as 
the destination frame. 

 

•  Save the document. 
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Testing the component 

• Create a new  Assembly document. 

• Create an  in-place part and a  block of 200 x 200 x 50mm. 

• Drag and drop the connector's assembly document into the assembly you just created. 

It is like when you position a screw; the connector will hook the nearest edges of the part. 

You should end up with the following result. 

 

• Drag and drop the wizard and the generic (part) of the connector into the Generic + Process + Wizard folder. 

• Delete the HARTING 16E Bottom Base source file. 

 

• Move the Connector folder to your library. 

•  Check the component into the vault, then  validate it. 
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Part component 

In this exercise, we want to create a slide. This part is driven as shown below. 

 

Designing the part 

• Open the Ex01 - Import and creation of components > Movement folders, copy the Slide part document and 
rename it My slide. 

The document contains the construction sketches and parameters of the part. 

  



TopSolid’Mold  Importing and Creating Components 

TopSolid   119 

• Create an  extruded shape from sketch 1 (slide section). 

• Perform a  trim by profile operation using sketch 2. 
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• From the Tools tab's drop-down menu, select the Functions >  Provide Function command. 

• Select the Slide function and fill in the fields with the part parameters. 

Note: The heel plane allows you to position the slide on the receiving plate. The basic frame (frame by point and 2 
directions) allows you to position the angle pin. The Z axis must be normal to the support face of the slide. 

 

•  Parameterize the part description as follows: Slide [lg]x[l]x[h]x[lt]x[ht]x[a]. 

•  Save the document. 

Creating the family 

• Create a  Family document from the My slide part document. 

• From the Entities tree's Generics folder, drag and drop the l, a, lg, h, lt and ht parameters into the Drivers 
folder. 

•  Save the family document. 
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Predefined drafting 

The final step in creating an intuitive component is to generate the related drafting. The goal is to save the user of 
the component from having to systematically recreate the drafting even if the dimensions/codes change. 

• Create a new  Drafting document from the My slide generic document. 

• Create a drafting similar to the one below. 

 

• In order to save time when setting the dimensions, display the annotations of the front view. To do this, right-

click on the front view and select the  Projected Annotations command. 

Note: As the component is parameterized, you have to define areas on each view. When resizing the slide, TopSolid 
will adapt the scale and recenter each view. 
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• Select the View >  Layout Sketch command and dimension the sketch as shown below. 

 

• Confirm the layout sketch. 

• Optimize the layout of the views using the View >  Optimize View Layout command. The views are replaced 
according to the layout sketch. 

• Declare the drawing as a predefined drawing using the Tools >  Predefined Drafting command. 

•  Save the drafting document. 
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Testing the component 

• From the Mold folder, open the Test mold document. 

• From the Construction tab, create a  frame on plane on the face as shown below. 

• Drag and drop the slide's family document, then assemble the slide as indicated below: 

- Insert plane: Select the support face of the insert. 
- Middle point: Select the point that will be used to center the slide. 
- Heel plane: Select the plane of the plate that will be used as a guide. 

 

• Enter the values of the slide, then click on  to confirm. 

•  Confirm the process. 
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You should end up with the following result. 

 

• Once all the tests are done, move the documents related to the slide to your library,  check in, then 

 validate the life cycle of the different documents of the component.  
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Assembly component with screws and processes 

In this exercise, we want to create two rails equipped with fixing screws. This assembly must be driven as indicated 
below: 

- Slide width = lt 
- Rail width = lg 
- Thickness = h 
- Length = l 
- Chamfer = Ch 
- Front clearance = ja 
- Rear clearance = jr 
- Diameter of the fixing screws = dv 

Creating the assembly 

• From the Ex01 - Import and creation of components > Movement folder, open the assembly document named 

 Rail. 

The document contains the following two sketches: 

- the sketch of the rail driven by l, lg and lt; 
- the sketch of the housing driven by ja and jr. 

 

• Create a new  in-place part using the Steel Part template. Rename this part Rail. 
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• Create the following two  real relay parameters, one being the rail thickness parameter and the other the 
chamfer parameter. 

  

• From the rail sketch, create an  extruded shape with a length = h. 

• Create a  chamfer using the Ch parameter on the external vertical edges. 

 

• From the Tools tab, select the Symmetries >  Plane Symmetry command. 

• Select the absolute XZ plane, then click on  to confirm. 

• Hide the symmetry plane. 

• Confirm the in-place editing. 
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We will now create a pattern to distribute a number of fixing screws that will adapt to the length of the rail. 

• From the Construction tab, select the  Constrained Linear Pattern command. 

• Fill in the fields as shown below (X=10mm, Y=15mm). 

 

• Rename pattern 1 Constrained linear pattern. 
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• From the Tools tab, select the Symmetries >  Plane Symmetry command. 

• Select the absolute XZ plane, then click on  to confirm. 

 

• Hide the symmetry plane. 

Reminder: The definition of the symmetry plane on the rail and in the assembly makes it possible to have two 
identical copies of the rail. 

• Select the  Quick Search command and enter E 1226. 

• Drag and drop the E 1226 Cylinder Head Screw, Flat Head component into the assembly document. Select the 
Screw Automatic Buried Head - Minimal length wizard. For the dimensioning, adjust the minimum diameter 
to dv=6mm and the minimum length to (h+dv*1.5)-dv/2. 

• Position the screw on the first frame of the constrained linear pattern as shown below. 
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• Adjust the following parameters for the process. 

 

• Repeat the screw using the constrained linear pattern. 

• Repeat the rail and the two screws by symmetry in relation to the absolute YZ plane. 
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• From the Tools tab's drop-down menu, select the  Processing Parts command and select the created 
screws. 

 

• Click on  to confirm. 

• Create a middle plane between the two rails, then publish it. Rename this publishing Slide Middle Plane. 

• Select the bottom plane of one of the rails and publish it. Rename this publishing Heel Plane. 

• Select the end plane of one of the rails and publish it. Rename this publishing Slide Plane. 

•  Save the Rail assembly document. 
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Creating the process 

• From the Tools tab, select the  Create Process command. 

• Create a  real relay parameter equal to the h parameter. 

• Create a sketch on the same plane as the housing sketch. 

• Create an  offset of 25mm. 

• From the sketch, create an  extruded shape with a length equal to h+50mm. This shape symbolizes the 
receiving plate of the rails. 

• Adjust the transparency to 75%. 

• Create a  pocket with a depth equal to h as shown below. 

 
  



Importing and Creating Components  TopSolid'Mold 

132   TopSolid 

• From the Tools tab, select the  Operator command and adjust the parameters as shown below. 

 

• Click on  to confirm. 

•  Save the Rail process document. 

Creating the wizard 

• If you closed the Rail assembly document, open it again. 

• From the Tools tab, select the  Create Wizard command. 

• Create a plane on plane constraint between the Slide Middle Plane published plane and the YZ plane. 

• Create a second plane on plane constraint between the Heel Plane published plane and the XY plane. 

• Create a third plane on plane constraint between the Slide Plane published plane and the XZ plane. 

You should end up with the following result. 

 

•  Save and close the Rail wizard document. 
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• Create a new  Family document from the Rail assembly document. 

• From the Entities tree's Generics folder, drag and drop the parameters into the Drivers folder. 

• Order the parameters as you wish. 

• Add a description for each of the parameters if necessary. 

 

• Create a new  Drafting document from the generic document, in the same way as for the My slide 
component.  
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Testing the component 

• If you closed the Test mold document, open it again, then position the rails. 

 

•  Confirm the process. 

 

• Check the values. 

• Adjust the properties for the bill of materials. 

• Once all the tests are done, move the documents related to the rail (generic, wizard, process, family and 

drafting) to your library,  check in, then  validate the life cycle of the different documents. 
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Additional exercise: Cotter 
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Movements 

The purpose of this exercise is to determine the best strategy for creating movements in a mold. 

 

• From the TopSolid'Mold Training D2 project, open the Ex03 - Movements folder. 

• From the 3- Mold folder, open the Elbow mold document. 

 

• Hide the A side by clicking on the  icon in the graphics area. 
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Positioning the components 

The movements consist of the following elements: 

- Slide 
- Cotter 
- Rails 
- Pin 

The strokes are as follows: 

 

Movement 1: Insert on the elbow's exit side 

Assembling the slide 

• Select the  Quick Search command and enter Slide. 

• Drag and drop the My slide family document into the mold document. 

• Adjust the values for the slide. 

 

Note: If necessary, you can modify the slide process by editing it from the Operations tree. You can modify the 
process length for large molds (by default 500mm).  
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Assembling the rails 

• In the quick search dialog box, enter Rails. 

• Drag and drop the Rails family document into the mold document. 

• Adjust the dimensions according to the slide. 

The slide width can be driven associatively in relation to an edge of the slide width. The same is true for the rail 
height. 
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Assembling the pin 

• Show the A plate. 

• From the Mold tab, select the  Angle Pin command. 

• Select Hasco as the manufacturer, then select Z 01 as the angle pin type with a diameter of 18mm. 

• Select the slide using rotary picking, then select the positioning plane of the angle pin. 

• Adjust the position of the angle pin along the slide. 
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• Adjust the measured stroke to 49.9mm. 

 

The standard length proposed by TopSolid is 280mm, which gives an actual stroke of 53.9mm. 

•  Confirm the creation of the slide derivation and the process. 

Angle pin pocket 

• From the Mold tab, select the  Angle Pin Pocket command. 

• Select the Oblong template, adjust the length clearance and the width clearance to 2mm, then check the 
Automatic detection box in the Parts to process section of the targets. 
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You should end up with the following cut result. 

 

Assembling the cotter 

• In the quick search dialog box, enter Cotter. 

• Drag and drop the Cotter family document into the mold document. 

• Position the cotter as shown below and adjust the values. 

 

•  Confirm the process. 

• From the Operations tree, select all the operations of this movement and create a folder named Movement 1. 

•  Save the Elbow mold document. 
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Movement 2: Insert on the diamond-shaped carriage nose side 

• Repeat the same steps as for movement 1. 

Adjust the values as you wish. 

Movement 3: Insert on the inclined pin side 

• Repeat the same steps as for movement 1. 

Adjust the values as you wish. 

• Finish the core and cavity blocks by performing Move face and Fillet operations.  

• Add the cotters to the A side set. 

You should end up with the following result. 
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Creating the final slides 

The final slide is the union of the slide with the insert. 

• Double-click on the slide to edit it in place. 

• Unite the slide and the insert. 

• Confirm the in-place editing. 

Result of the exit slide: 

 

Because of the union between the insert and the slide, there is an extra part in the assembly. To avoid this, you can 
delete the insert as an operation. 

• Hide slide 1. 

• From the Assembly tab, select the  Removing command and select the insert 1. 

A removing operation is then added in the Operations tree. 

• Repeat the procedure for the other two slides. 

 

• Show all parts. 

•  Save the Elbow mold document. 
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Part Replacement 

The purpose of this exercise is to determine the best strategy for modifying your parts. 

Overview of a mold's documents 

 

In order to study the impact of the new part's modifications, it is recommended that you import the new PDD by 
using the following rules. 

Functional overview for any import 

 

Operating process 

• From the TopSolid'Mold Training D2 project, open the Ex02 - Part replacement folder. 

Operating overview 

 

We want to replace the Bracket v1 part with its new version Bracket v2, and we want to work on a copy of the core 
and cavity block's assembly in order not to modify the mold immediately. 
We will create a new version of the core and cavity blocks. 

In the image below, the version 1 of the part is shown in blue. 
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• From the 2- Core cavity blocks v1 folder, open the Core cavity blocks bracket v1 Split document. 

• From the Split tab, select the  New version command. 

• Enter v2 in the Name field. 

• Create a subfolder named 2- Core cavity blocks v2 in the Ex02 - Part replacement folder. 

 

•  Confirm. 
 

• Close the Core cavity blocks bracket v1 Split document. 

• Rename the Split and Assembly documents Core cavity blocks bracket v2. 

• Open the Core cavity blocks bracket v2 Split document. 

• Open the Bracket v2 part document from the 1- Customer part folder. 

• Return to the Bracket v1 - v2 part document. 

• From the Shape tab, select the  Replace command. 

• In the New shape field, select the Bracket v2 document from the drop-down list. 
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The screen is then divided into two panes with a graphical synchronization of the views in both documents. Any 
zoom or rotation in a document will be applied in the other document. 

 

•  Move to the next step. 

• Click on Different loops to quickly identify the changes between both parts. 

 

•  Move to the next step. 
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• In the Document field, select Core cavity blocks bracket v2. 

• Select the Used option for the faces and edges. 

 

• Click on  to confirm, then close the Bracket v2 document to avoid confusion. 

The shape v1 is then replaced with the shape v2 in the core cavity blocks bracket v2 Split document. 

Operations performed in the first version of the core and cavity blocks: 

  

• Open the Core cavity blocks bracket v2 Split document. 
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When the document is open, the following error messages appear. 

• Click on OK to confirm and move to the next error. 

 

 

The document is then invalid. 

Here is the state of the Operations tree in the parting stage: 

- The candidate parting edges are no longer up to date. 
- The external parting edge has been modified. 
- The pocket has disappeared; the Parting Edges-Pocket and Shut Off Surfaces-Pocket operations are no 

longer necessary. 

 

Repairs 

• Switch to the  parting stage. 

• Move down the  Parting Stage cursor over each operation to be modified in order to avoid the series of error 
messages, and move it up manually after each repair operation. 

• Edit the Candidate Parting Edges operation to repair it. 

• Edit the Parting Edges-External operation and select the new edges. 

• Delete the Parting Edges-Pocket operation. 

• Edit the Parting Edges-Hole operation and select the new edges. 

• Delete the Shut Off Surfaces-Pocket operation. 
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At this stage, the parting shapes need to be recalculated. 

• Click on the  icon in the document's tab. 

• Update the parting shapes and the core and cavity blocks. 

• From the core and cavity block creation dialog box, delete v1 in the part names. 

•  Save and close the Core cavity blocks bracket v2 Split document. 
 

• Open the Core cavity blocks bracket v2 assembly document. 

The document is invalid. 

• Click on the  icon in the document's tab. 

The frame's origin point is invalid because of the changes. 

 

• Click on the middle of the edge to repair. 

•  Save the Core cavity blocks bracket v2 assembly document. 

At this stage, you have defined the new core and cavity blocks version 2. 
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Replacing the new assembly in the mold 

The mold document must be checked into the vault before any operation in order to return to a stable stage if 
problems arise. 

• From the 3- Mold folder, open the Bracket mold document. 

Note: At this stage, only the Bracket mold and Core cavity blocks bracket v2 documents must be open. 
 
We will now replace "Core cavity blocks version 1" by "Core cavity blocks version 2". 

 

• From the Operations tree, open the node of the Core Cavity Blocks Inclusions and Positioning 1 operations. 

• Edit the inclusion, select the Core cavity blocks bracket v2 document, then click on  to confirm. 

 

TopSolid then updates the mold. 

• Hide the A side by clicking on the  icon in the graphics area. 

You will notice that two pins fall off after the part modification. 

 

• From the Operations tree, open the Pins folder and delete pins 4 and 9. 

•  Check the Bracket mold document into the vault.  
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At this point, you have: 

- replaced your part by its new version; 
- kept track of your file before this modification. 
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Cooling Circuit Control 

In this exercise, we will see how to control collisions between the cooling circuit and its surrounding elements: 
holes, pins, etc. 

• Import the TopSolid'Mold Training D3.TopPkg project. 

• From the Ex01 - Cooling circuit control folder, open the Electrical outlet plate mold document. 

• Hide the A side by clicking on the  icon in the graphics area. 

• From the Mold tab, select the  Cooling Circuit Collisions command. 

• Adjust the safety margin to 5mm and check the Collisions with Parts and Collisions with Holes boxes. 

 

TopSolid then creates two groups of collisions in the Entities tree's Cooling Collisions folder. 
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• Open the Collisions with Parts folder, then right-click on the first collision and select the  Show Alone 
command. 

 

• You can exclude the collisions that you deem acceptable. To do this, right-click on the collision and select the 

 Exclude command. The excluded collision then moves to the Exclusions folder. 

• To find out the effective length of the circuit, press the F8 key, position the cursor on the circuit and press the 
Shift key. 
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Manual Drafting Bundle 

In this exercise, we will see how to create a single document that groups together all the drawings of your study. 

• Open the Ex02 - Drafting bundle folder, and then the Drawings folder. 

• Create a new  Drafting Bundle document (Advanced tab) using a blank template. 

• Exit the Inclusion command since no drafting document is open. 

• Right-click on the frame shown on the screen and select the  Edit command. 

 

• Select the A0 Landscape format. 

 

Creating pages 

• From the Drawings folder, drag and drop the Electrical outlet plate drafting document into the drafting bundle 
document. 

• For the inclusion, select All pages. 

 

TopSolid automatically creates two pages. 

• Click on the  Add page icon at the bottom left of the graphics area. 
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• From the Drawings folder, drag and drop the Electrical outlet plate.Cavity block drafting document into the 
drafting bundle document. 

• Leave the 1 page mode. 

 

The drafting bundle behaves like an assembly document with a reduced set of commands: Point on Point, Axis on 
Axis, Axis on Point, Point on Axis and Orientation. 

 

• Click on the bottom left point of the Electrical outlet plate.Cavity block document, then click on the bottom left 
point of the drafting bundle document. 

  

• Repeat the procedure with the other drawings, making sure to exit the constraint command each time you 
include a drawing. 

• Drag and drop the drawings until the frame is filled as shown below. 
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• Add a new page. 

At this stage we will see how to rotate a drawing. 

• Drag and drop the following drawing. 

• Click on the top left point of the drawing and move it to the bottom left point of the drafting bundle document. 

• Exit the constraint command. 

• Right-click on the drawing and select the  Anticlockwise Quarter Turn command. 

 

• Repeat the procedure for the following drawing. 

 

You should end up with the following result. 
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Modifying the layout 

• Click on the  Page Sorter icon at the bottom right of the drafting bundle document to access the document's 
layout. 

 

The frame around page 1 and page 2 means that these pages are linked. 

• If you want to switch the page 4 to the page 3, simply drag and drop the page 4 onto the page 3. 

 

• Click on the  Page Sorter icon again to return to page mode. 

• If you want to edit a drawing, you only have to double-click on it. 
The In Place Editing context of your drawing is then enabled and all the drafting commands are available. 

 

• Once changes have been made, confirm the in-place editing to return to the drafting bundle document. 

•  Save the drafting bundle document. 
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Core and Cavity Blocks from a Block 

In this exercise, we will see how to design a mold with core and cavity blocks made from a block. 

• Open the Ex03 - Core cavity blocks folder. 

The stock of your Split document must be sized according to the dimensions you want to apply to your mold's 
standard plates (here, 346 x 496). 

 

• Create a new  Mold document using a blank template. 

• Include a 346 x 496 Meusburger mold base, select Type 2 as the template and adjust the following dimensions 
for the plates. 
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• From the Assembly tab, select the  Removing command and select the two core and cavity blocks. 

 

• From the Split folder, drag and drop the Flower pot assembly document into the mold document. 
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• Assemble the core and cavity blocks using the appropriate positioning constraints. 

 

Executing the processes 

• Hide the B side. 

• Right-click on the first fixing screw of the clamp plate and select the  Use Process command. 

• Repeat the operation for the four screws, and then for the four guide pins. 

You should end up with the following result for the cavity block (A side). 

 

• Hide the A side. 

• Show the B side. 

• Right-click on the first fixing screw of the clamp plate and select the  Use Process command. 

• Repeat the operation for the four screws, and then for the four guide bushes. 
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You should end up with the following result for the core block (B side): 

 

Modifying the properties 

• Open the core block (B side). 

• Right-click on the shape and edit the derivation. 

• Uncheck the Name, Description, Code, Manufacturer and Manufacturer Part Number parameters. 
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• Enter the following properties. 

 

• Repeat these steps for the cavity block (A side). 

•  Save the document. 
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